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Federal Communications Commission
Radio Frequency Interference Statement

WARNING:  This equipment generates, uses, and can radiate radio
frequency energy and if not installed in accordance with the
instruction manual, may cause interference to radio communications.
It has been tested and found to comply with the limits for a Class A
computing device pursuant to Subpart J of Part 15 of FCC rules,
which are designed to provide a reasonable protection against such
interference when operated in a commercial environment.  Operation
of this equipment in a residential area is likely to cause interference
in which case the user, at his own expense, will be required to take
whatever measures may be required to correct the interference.
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LI-COR, inc.
Environmental
4421 Superior Street
P.O. Box 4425
Lincoln, Nebraska  68504 USA

Phone: 402-467-3576
FAX: 402-467-2819
Toll-free: 1-800-447-3576 (U.S. & Canada)
E-mail: envsales@licor.com

Declaration of Conformity

Manufacturer’s Name:  LI-COR Inc.

Manufacturer’s Address:  4421 Superior Street
Lincoln, Nebraska USA 68504

declares that the product

Product Name:  Infrared Gas Analyzer

Model Number(s):  LI-820

Product Options:  None

conforms to the following Product Specifications:

FCC CFR Part 15.109 Radiated Emissions, Class A
FCC CFR Part 15.107 Conducted Emissions, Class A

IEC 61326 : 1997/A2:2001 Radiated Emissions, Class A
IEC 61326 : 1997/A2:2001 Conducted Emissions, Class A
IEC 61000-4-2 : 1995/A2:2000: ESD, 4KV/8KV Contact/Air
IEC 61000-4-3 : 1995/A2:2000: Radiated RF Immunity, 10V/m
IEC 61000-4-4 : 1995/A2:2000: EFT/Burst
IEC 61000-4-5 : 1995/A2:2000: Surge
IEC 61000-4-6 : 1996/A1:2000: Conducted RF Immunity
IEC 61000-4-8 : 1993/A2:2000: H-Field Immunity, 30A/m
IEC 61000-4-11 : 1994/A2:2000: Voltage Dips

Supplementary Information:

The product herewith complies with the requirements of the EMC Directive 89/336/EEC.

Dave Dilley
Director of EngineeringDocument #53-06935

February 1, 2002
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photocopied, reproduced, or translated to another language without prior written consent of LI-COR, Inc.
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Printing History
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1 General Description

What's What

This procedure should be followed if you have just taken delivery of your
LI-820.  Check the packing list to verify that you have received everything that was ordered
and that you have also received the following items:

� RS-232 Cable - (Part #392-04993), used to connect the LI-820 to your computer.

� 820-500 Data Communications Software - This Windows® 95/98/NT/2000/XP/ME
compatible software is used to communicate with your computer.  The software is
provided on CD.  A complete description of this software can be found in Section 3,
Operation.
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� Standard Spare Parts Kit (9980-012) - This kit contains replacement parts for your
LI-820.  As you become familiar with the analyzer you will learn which items to keep
close at hand and which items can be stored away.  The spare parts kit contains these
items:

Description Qty. LI-COR Part No.

Polyurethane Mounting Feet 4 234-02268
Mounting Screws 4 149-02610
Terminal Block 1 250-05340
Bev-a-line Tubing 12' 222-01824
Balston Disposable Air Filter 2 300-01961
Quick Connect Unions 2 300-03123
Rapid Tube Fitting Nut 2 9861-036
1.6A Fuse 2 439-04537
Cleaning Kit, includes: 1 9980-013

3" Cleaning Swabs 5 610-05314
5" Cleaning Swabs 5 610-05315
O-Rings 4 192-00226
Pre-formed Optical Bench Tubing 4 6580-010
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Features

The LI-820 is an economical high performance, non-dispersive infrared gas analyzer designed
to be used for a wide variety of applications.  Some of the LI-820's important features include:
� Optional short (2") and standard long (5.5") interchangeable optical benches can be used

to obtain resolutions of 0-20000 ppm and 0-2000 ppm, respectively.  No changes in
calibration polynomials or software need to be made when swapping optical benches; you
may need to recalibrate the instrument, however.

� Optical benches are fully serviceable by the user; cleaning the optical benches is a simple
process, and does not affect the instrument calibration.

� Simple Windows® software provides for easy user calibration and data output.

Precautions

� The optical bench is maintained at a constant 50 °C.  Avoid direct exposure to sunlight or
extremely high temperatures that may elevate the temperature inside the LI-820 case.

� The optical source is sensitive to vibration, and can be damaged by strong vibrations or
jarring.  Do not drop the LI-820, or expose it to severe mechanical shock.
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� Do not use abrasive cleansers when cleaning the optical bench, as damage to the gold
plating may result.  Instructions for cleaning the optical bench can be found in Section 5.

� Always filter air entering the LI-820.  Two Balston filters are included in the spares kit.

Getting Started Tutorial

The following section briefly covers the basic steps you might follow to set up the LI-820 to
collect and record data.  Many of these steps are described in greater detail throughout this
manual.

1 Install the 820-500 PC Communications Software.

This software is used to set the zero and span of the LI-820 and to set up data communication
and data transfer parameters.  Installation instructions can be found in Section 3, Installing the
Software on Your Computer.

2 Determine your jumper settings for high and low alarm output, if
required.

There are 2 jumpers inside the LI-820 case (on the main circuit board) which toggle the high
and low alarm output between 0-5V (TTL levels) and an open drain condition.
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The default jumper positions are set for 0-5V output for both high and low alarms.  This alarm
configuration is suitable for logic devices such as dataloggers.  To use the high and/or low
alarms to operate a relay switch, the jumpers should be reconfigured for open drain output.
See Section 2, Alarms, for a description of how to change the alarm jumper settings.

If the default jumper positions are suitable for your application, or if you do not intend to use
the alarms, proceed to Step 3.

3

+ -

1 2 3 4 5 6 7 8 9 10 11 12 13 14

Connect a power source to the LI-820.

The LI-820 requires an input voltage of 12-30 VDC.  The power supply must be able to source
a maximum current drain of 1.2A (at 12 VDC).  After the instrument has warmed up it will
draw about 0.3A (at 12 VDC) with the heaters on.  Bare wire leads are connected to the
terminal strip at positions 1 and 2.  Connect the positive lead to position #1 (12-30VDC), and
the negative lead to position #2 (GND).

NOTE:  Pull straight out on the face of the terminal strip to remove it; this can make it
easier to connect the wires.
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4 Connect the RS-232 cable.

Connect one end of the serial cable to the 9-pin Serial I/O port on the LI-820 front panel, and
the other end to a serial port on your computer.  If you want to interface to a device with a 25-
pin serial port, a 9-pin to 25-pin adapter must be used; a gender changer may be required in
some cases, also.  Tighten the two screws on the ends of the serial cable.

5 Connect other output device(s) if desired.

Output devices such as dataloggers and relay switches for high and low alarms are connected
via the terminal strip.  A complete description of the terminals can be found in Section 3,
Using the Terminal Strip.

6 Hook up the input air stream and external filter.

Remove the nut from the Flow In fitting and connect a short (12" or so) piece of Bev-a-line
tubing (in the spares kit).  Tighten the nut.  Place a Balston filter (also in the spares kit) in the
sample airstream before it enters the FLOW IN port on the LI-820.

IMPORTANT:  Always install the external air filter before operating the LI-820.
Insert filter into the input airstream before it enters the LI-820.  Failure to do this
will lead to contamination of the optical path.
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There are some quick connect fittings in the spare parts kit that can be used on either side of
the Balston filter to aid in changing the filter out.  Press on the red part of the fitting to release
the tubing.

When using the LI-820 for applications where sample air is particularly dirty, you may
consider stacking two filters in series.  For maintenance, replace the filter furthest upstream
from the analyzer with the filter closest to the analyzer and replace the filter closest to the
analyzer with a new filter.

BALSTON
DFU®

Grade

Install the new filter(s) with the arrow facing toward the FLOW IN port.

The air inlet and outlet ports should be covered with the dust caps provided or attached to an
air line when the instrument is not in use.  This will prevent dust from entering the instrument
downstream from the filters where it can enter the optical path.

Replacement Balston air filters can be obtained from LI-COR (part #300-01961).
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7 Start the 820-500 PC Communications Software.

Click on the program icon to start the 820-500 program.  The 820-500 Main window appears.
Select Connect from the File menu.  Choose the serial port to which the LI-820 is connected,
and the data output interval.  Select the COM port and the data output interval, if desired, and
click the Connect button.  If the analyzer is connected properly, data will appear in the main
window.

8 Configure the analyzer.

Select Settings from the View menu.  The Settings window appears.  Select the CO2 range

(the 'Span Range' radio buttons) over which you will be measuring CO2.  Choose a value for

signal averaging (the Filter field), between 0 and 20 seconds.  Set values for high and low
alarms and corresponding dead bands, if desired.  See Section 2 for a complete description of
the alarms.  If you are using an output device to collect data, choose the value to be output at
DAC 1 and/or DAC 2.  Make sure the Heater and Pressure Compensation buttons are enabled
(checked), and click OK.

9 Set the analyzer zero.

Connect a dry, CO2-free gas to the input air stream.  Select Calibration from the View menu.

Click on Zero.  After about a minute, a message will appear that indicates the IRGA is zeroed.
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10 Set the analyzer span.

Connect your span gas to the input air stream.  Note that your span gas concentration must not
exceed the span range chosen in the Settings dialog from Step 8 above.  Enter the value of the
span gas.  Click on Span.  After a few minutes, a message will appear indicating the span
calibration is completed.  Click Close.

11 Set up the logging parameters.

Select Options from the Logging menu.  Choose the File Header(s) to be output with the data,
the values to be logged, the field delimiter, and log frequency.  Click OK.  Choose Start from
the Logging menu.  Enter a file name for the data file.  Click Save.

12 Set up the charting parameters, if desired.

Select Charting from the View menu.  Enter the Y-Axis min and max values, X-Axis max,
and time units to be displayed on the plot.  Click Start to begin recording data.  A graph with
data will appear in the window and data will be logged to the file designated in Step 11 above.

13 Choose Stop from the Logging menu to close the data file and
stop recording when you are done collecting data.
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2 Power On

Power On

The LI-820 can be connected to a constant source of AC power using a transformer that
provides 12-30VDC (12W minimum) to the LI-820.  If the LI-820 is powered On with a
battery below 10.5 volts, the analyzer will not power up, and the Low Battery LED on the top
panel will illuminate.

Low Battery Indicator

The low battery LED on the LI-820 top panel will illuminate when the battery voltage drops
below 10.5 volts.  The LI-820 will continue to operate with a low battery; there will, however,
be a corresponding reduction in performance.
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Alarms

The LI-820 is equipped with high and low alarms, which can be configured as open collector
or 0-5V output (TTL levels) using jumpers on the main PC board (Figure 2-1).  The default
configuration is 0-5V output.  Figure 2-2 shows the position of the jumpers for each of the
two alarm conditions.
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Alarm
Jumpers

Figure 2-1.  Location of alarm jumpers LK1 and LK2.
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Figure 2-2.  Position of jumpers for open drain and 0-5V output.
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In addition, a "dead band" value can be set in software for both high and low alarms.  To
understand how the alarms and dead band values work, look at the diagram below.
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In this chart, the low and high alarm values are set to 100 ppm and 1000 ppm, respectively.
The dead band value in both alarms is set to 100 ppm.  When the CO2 concentration reaches

1000 ppm, the high alarm is activated, and remains active until the concentration drops below
900 ppm.  When the CO2 concentration falls below 100 ppm, the low alarm is activated, and

remains active until the concentration rises above 200 ppm.  Your choice for the dead band
value(s) depends on your application, and the fluctuation in CO2 concentrations over time.
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Note: Increasing the signal average value in software (see Settings Window; Options;
Filter in Section 3) can help reduce fluctuations in readings.

Alarm LEDs can be viewed on the top panel of the LI-820.  Terminals 3 and 5 on the terminal
strip are also connected to the High and Low alarms, respectively.  This is useful in cases
where you want to connect an audible alarm, for example, or a relay switch to operate another
device that will raise or lower the CO2 concentration to the desired level.  The schematic

diagram below shows how the high alarm could be connected to a relay switch that triggers an
exhaust fan in a greenhouse environment.  These relays could also be used to trigger devices
such as automatic dialers, alarms, pumps, and valves in industrial and other environments.
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A list of suppliers of electronic relay switches can be found in Appendix C.

NOTE:  Consult your local electrical codes before wiring, and/or have a professional
electrician wire your application.



Operation 3-1

3 Operation

Installing the PC Communications Software on Your Computer

The 820-500 software is shipped on CD.  It requires that your computer have an RS-232 serial
(COM) interface, and Windows® 95/98/NT/2000/XP/ME.  The program runs on any true PC-
compatible computer.

An installation menu starts when you insert the CD into your CD-ROM drive.  Select Install
Software from the menu and follow the instructions.  If installation does not start, select Run
from the Windows Start menu, and select the LI820Setup.exe file on the CD.  When the
software has finished the installation procedure, a program icon will be placed in the Programs
menu.

NOTE:  To remove the software, go to the Control Panel and select Add/Remove
Programs.  Choose LI820 from the list of programs and click the Add/Remove button.



Section 3

3-2 Operation

Setting the Communication Parameters

LI-820 communication parameters are set automatically when the program is run.

Cabling

The serial cable included has 9-pin connectors on both ends; either end plugs into the 9-pin
connector (Serial I/O) on the front panel of the LI-820.  Use this cable to interface with your
computer's 9-pin serial port.  If you want to interface to a computer with a 25-pin serial port, a
9-pin to 25-pin adapter must be used.

RS-232 Output

Data from the LI-820 can be transferred to a computer for analysis, printing or storage using
the RS-232 interface.  The LI-820 RS-232 port is configured as Data Terminal Equipment
(DTE) with no hardware handshaking, and is bi-directional, meaning information can be
transferred both into and out of the LI-820.

The 820-500 PC Communication Software that comes with the LI-820 is used to transfer data
and setup files between the analyzer and the PC.
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Initial Setup

Click on the LI-820 program icon to start the program.  The LI-820 Main Window appears.
Select Connect from the File menu.  You are asked to select the serial port to which the
LI-820 is connected, and the output interval at which data are output (0.5 to 20 seconds, in 0.5
second increments).

Choose a port and the output interval and click Connect.  If the instrument is connected
properly, data will begin to appear in the window:
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The Main window displays the CO2 concentration (ppm), as well as the status of various

LI-820 parameters.  There are also three menus used to configure the LI-820, perform zero
and span calibrations, and set up the parameters for recording data.  The LI-820 parameters in
this window are as follows:

Parameter Description

Cell Temperature Temperature (°C) in the LI-820 optical cell.  This value should
remain near 50 °C when the heater is turned ON.

Cell Pressure Barometric pressure (kPa) measured in the LI-820 optical cell.  This
value can be used to correct CO2 measurements for the effects of

pressure fluctuations on gas density and band broadening.

Heater Shows status of heater (ON/OFF), which is used to maintain the
optical cell at a constant 50 °C.  The heater is turned ON/OFF in the
Settings window.

Pressure Comp. Shows whether pressure compensation is ON/OFF.  When ON, CO2

measurements are corrected for the effects of pressure fluctuations
on gas density and band broadening.

Alarms Shows status of High and Low alarms, whose values are set in the
Settings window.  Alarms are enabled (ON), or disabled (OFF).



Section 3

3-6 Operation

Parameter Description

Filter Shows the current value for software signal averaging, set in the
Settings window.  The filter can be set from 0 (no signal averaging)
to 20 seconds.

Span Displays the span range currently selected.  With the 14 cm optical
bench, span ranges of 0-1000 or 0-2000 can be selected.  With the 5
cm optical bench, span ranges of 0-5000 or 0-20000 can be selected.

Path Length Shows the size of the optical bench installed in the LI-820, either 5.5
inches (14 cm), or 2 inches (5 cm).

Using the Toolbar
The toolbar in the Main window contains shortcuts for some of the commonly used menu
items:

Connect

Disconnect

Start
Logging

Stop
Logging

Pause
Logging

Settings

Charting
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Settings Window - Setting Operational Parameters

The Settings window contains parameters related to initial setup of the LI-820, including the
resolution of the optical bench, signal filtering, high and low alarm setup, heater and pressure
compensation options, and DAC output sources.  Choose Settings from the View menu (or
click on the toolbar icon) to open the Settings window:
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Range of optical 
bench.  5000 
and 20000 ppm 
will be greyed 
out if 5.5" optical 
bench is 
installed.  
Similarly, 1000 
and 2000 will be 
greyed out if 2" 
bench is 
installed.

DAC output 
range.  Choose 
source to be 
output to DAC 1 
(terminal strip 
connector #9), 
and/or DAC 2 
(terminal strip 
connector #7).

Software signal 
filtering is available 
from 0-20 seconds.

The heater should 
be enabled to 
maintain the 
optical bench at a 
constant 50 °C.  
Pressure 
compensation and 
DAC offset are 
optional 
parameters.

Disable the 
alarms here, or 
set high and 
low alarm 
values, and 
high and low 
dead band 
values.
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Options
Enable Heater
The Heater should be enabled to maintain the optical bench at a constant 50 °C.

Pressure Compensation
Enable the Pressure Compensation check box to automatically correct gas concentration
values for changes in cell pressure.  In most cases this should be turned on; disabling this
feature means that no pressure correction is desired in the gas concentration calculations,
which can lead to erroneous measurements.

Filter
Shows the current value for software signal averaging.  The filter can be set from 0 (no signal
averaging) to 20 seconds.

Alarms
Allows you to enable/disable the alarms, and enter high, low, and dead band values.  A
complete discussion can be found in Section 2, Alarms.

Span Range
The span range buttons determine the maximum CO2 range over which the LI-820 will make

measurements.  If the 14 cm (5.5") optical bench is installed, 5000 ppm and 20000 ppm will
be greyed out.  Similarly, if the 5 cm (2") optical bench is installed, 1000 ppm and 2000 ppm
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will be greyed out.  Note that there are two benefits to selecting the 0-1000 ppm range if this
range is adequate for your experiment.  First, the narrower range provides better resolution in
terms of the digital-to-analog converter (DAC).  Each step of the DAC is able to resolve twice
as many data points as compared to the 0-2000 ppm range, which results in beter resolution.
Secondly, the 0-1000 ppm range has a unique 4th order polynomial, which provides a better
"curve fit", and ultimately improved accuracy over this range.

Note that your span gas concentration must not exceed the selected span range (1000, 2000,
5000, or 20000 ppm).

DACs
Analyzer output for up to 2 values (CO2, Cell Temperature, or Cell Pressure) can be recorded

by connecting a logging device to the terminal strip on the front of the analyzer.  Output is
linear, and is selectable at 0-5V or 0-2.5V.  Choose the output range and the source for DAC 1
and/or DAC 2.  Available output sources are CO2, Cell Temperature, and Cell Pressure.

The DACs in the LI-820 are bipolar, and will go slightly negative (~-0.100V).  This can
happen, for example, if the cell becomes contaminated or just from small random
perturbations when the CO2 concentration is near zero.  See Section 5, Cleaning the Optical
Bench for instructions on cleaning the cell should it become contaminated.
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Voltage output is measured by attaching the positive lead from the logging device to terminal
9 (V Out 1), or terminal 7 (V Out 2) on the LI-820 terminal strip.  Connect the negative lead
to position 10, (GND), or position 8.

The CO2 concentration can be calculated from the DAC output voltage as follows:

CO V
C

V2
range

range

=






3-1

where V is the measured voltage, Crange is the maximum value of the CO2 range selected (0 to

1000 ppm, 0 to 2000 ppm, etc.), and Vrange is the maximum DAC output for the selected

range (0-5V or 0-2.5V).

Example:  The voltage output is set for 0-5V output (Vrange), the maximum CO2 range
chosen is 2000 ppm (Crange), and the measured output voltage (V) is 2.9V.  To calculate the
CO2 concentration (no offset) from Equation 3-1 above,

CO 2.9V
2000 ppm

5V2 = 





3-2

= 1160 ppm.
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Converting Voltage Output to Cell Temperature
Cell temperature can be calculated from the DAC output voltage as follows:

Temp. V
100 C
Vrange

= °





3-3

where V is the measured voltage output and Vrange is the maximum DAC output for the

selected range (5.0 or 2.5 volts).

Converting Voltage Output to Cell Pressure
Cell pressure can be calculated from the DAC output voltage as follows:

Pressure V
1 5 kPa

Vrange

=






1 3-4

where V is the measured voltage output and Vrange is the maximum DAC output for the

selected range (5.0 or 2.5 volts).
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Converting Current Output to ppm CO2
Current output can be measured by connecting the positive input of the data logging device to
positions 11 or 13 (4-20 mA 1 or 4-20 mA 2), and the negative input to position 12 or 14
(GND).  The current output at positions 11 and 13 is non-isolated, and is rated to drive a 250
ohm load.

To convert current output (I) to units of ppm CO2 in your computer or other output device, the
following equation can be used:

CO
C

16
I 42

range= −( ) 3-5

where Crange is the maximum available CO2 resolution (1000, 2000, 5000, or 20000 ppm),
and I is the measured current output in mA.

Example:  You have chosen 2000 for the range of the LI-820.  The measured current output
is 16.25 mA.  To convert to ppm CO2:

CO
2000

12 = −( )
16

6 25 4. 3-6

= 1531.25 ppm.
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Using the Terminal Strip

The terminal strip is located on the front panel of the LI-820.  To connect the wires, insert the
bare wire end into the appropriate terminal and tighten the screw above that terminal using the
small flat head screwdriver in the spare parts kit.  The front face of the terminal strip can be
removed to aid in connecting the wires by pulling straight out on the face.

1 2 3 4 5 6 7 8 9 10 11 12 13 14
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The terminal positions are as follows, reading left to right:

Terminal Label Description

1 12-30 VDC Voltage In, 12-30 VDC
2 GND Ground
3 High Alarm High Alarm
4 GND Ground
5 Low Alarm Low Alarm
6 GND Ground
7 V OUT 2 Voltage output channel 2
8 GND Ground
9 V OUT 1 Voltage output channel 1
10 GND Ground
11 4-20 mA 2 Current output channel 2
12 GND Ground
13 4-20 mA 1 Current output channel 1
14 GND Ground
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Charting Window

Select Charting from the View menu to open the Charting window (below).  This is the
window in which you can set up the parameters for plotting your data.
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X-Axis Max
Sets the maximum value for the X axis (Time).  The units for the X axis can be seconds or
minutes.

Y-Axis Max/Min
Sets the maximum and minimum values for the Y axis (CO2).

Press Print Chart to send the current chart to your printer.  Press Save Chart to save the chart
as a bitmap (.bmp) file.

Press Start at any time to view the chart layout and begin displaying data.  Note that you must
press Stop to make changes to the chart parameters, and then press Start again to resume data
display.
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Diagnostics Window

Select Diagnostics from the View menu to open the Diagnostics window (below).  This
window displays the current LI-820 internal software version number, the input voltage, and
raw absorption value.
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Logging Data

Start Logging
Opens the Log File Destination dialog, where you enter a file name for the data file.  The file
extension .txt is added automatically.
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Stop Logging
Stops data logging.

Pause Logging
Pauses logging of data until Start is chosen from the Logging menu again, or the Start button
on the toolbar is pressed.

Options
Opens the Logging Options window, where you can configure the data output options.
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As configured above, the data output would appear similar to that shown below.

File Headings

Log Values

System
Time (1s
log rate)

Cell
Temp.

Cell
Pres.

CO2
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Calibration Window - Setting the Zero and Span

Select Calibration from the View menu to open the Calibration window.  This is the area in
which you set the zero and span of the LI-820.
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It is recommended that you perform the zero calibration first, followed by the span
calibration.  To zero, flow a dry, CO2-free gas through the LI-820, and make sure the optical

cell is completely purged.  Press the Zero button.  The display will show ZERO, and the text
in the Calibration window is greyed out.  The zero will be set electronically, and the current
date will be entered in the "Last zeroed on" field when completed.

To span, connect your span gas to the input air stream.  Make sure the cell is purged, enter the
value of the span gas, and click on Span.

The display will show SPAN, and the text in the Calibration window is greyed out.  The span
will be set electronically, and the current date will be entered in the "Last spanned on" field
when completed.
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Connecting the LI-820 to the LI-1400 Datalogger

Fct

On/Off

Setup Enter

7

4

1

0

8 9

5 6

2 3

Esc

EEX
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Shift

M P

T

X Y Z
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HG
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F

B

E
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D

The following example shows how you can connect the LI-820 to a datalogging device such
as the LI-COR Model LI-1400 DataLogger to collect analog data and convert to meaningful
CO2 values.  As mentioned earlier, voltage output from the LI-820 is linear; converting analog

data into ppm CO2 simply requires multiplying the raw mV output by a conversion factor,

which is dependent upon the selected voltage output range, and the maximum CO2 resolution

available (set in software at 0-1000 or 0-2000 ppm with the 5.5" optical bench, or 0-5000 or
0-20000 ppm with the 2" optical bench).  In general, the conversion takes the form

CO V
C

V2
range

range

=






3-7

where V is the measured voltage, Crange is the maximum value of the CO2 range selected (0 to

1000 ppm, 0 to 2000 ppm, etc.), and Vrange is the maximum DAC output for the selected

range (0-5V or 0-2.5V).

For example, if the voltage output is set for 0-5V output, the maximum CO2 range is 2000

ppm, and the measured voltage output is 2.9V, the equation would take the form
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CO 2.9V
2000 ppm

5V2 = 





3-8

= 1160 ppm.

This general equation can be converted into simple multipliers, based on the two known
voltage output ranges, and the four values for maximum CO2 resolution (1000, 2000, 5000

and 20000).  This multiplier can then be entered in the data logging device to convert raw
voltage to CO2 values.  Table 3-1 lists the appropriate values for this multiplier; simply

choose your DAC output range in the second row, and then select the LI-820 maximum CO2

range in the first column; follow across to find the appropriate multiplier.
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Table 3-1.  Multipliers for Converting Voltage Output to CO2 Readings

DAC Output Range

Crange

0-1000 ppm

0-2000 ppm

0-5000 ppm

0-20000 ppm

200

400

1000

4000

0-5V

Multiplier (ppm/volt)

400

800

2000

8000

0-2.5V

The LI-1400 can be used to monitor voltage signals up to 2.5 volts with 76 microvolt
resolution in real time and convert them into meaningful engineering units shown on the
display.  Alternatively, the LI-1400 can be configured to automatically log these data over
extended periods of time and later dump the results to a computer for further analysis.

Access to the voltage channels require the 1400-301 Terminal block.  Voltage channels are
designated by the letter “V” and sequentially numbered V1-4.  The lead from LI-820 terminal
#7 or #9 should be attached to one of the LI-1400 terminals labeled V1, V2, V3, or V4, while
the lead from terminal #8 or #10 should be attached to one of the LI-1400 terminals labeled ↓.
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The following example shows how you can set up the LI-1400 Data Logger to collect raw
voltage output from the LI-820 and convert to CO2 values.

1.  Set the voltage output of the LI-820 for 2.5V output as described in Section 3, Analog
Output.

2. In the LI-1400, configure V1 channel as General for CO2.

3. Enter a description, such as CO2.

4. Set Math = Poly(nomial) and press Ent(er).

5. Set description as desired, a1 = multiplier from Table 3-2 above, a0, a2-a5 = 0.  When
finished, press Esc to return to the main configuration list.

6. Set Oper(ator) = none.

7. Enter a Label such as ppm for the units.

8. Set Average=1 sec or as desired.  CO2 will now be displayed on channel V1.

To log CO2 automatically, follow the remaining steps:

9. Set Log Routine to the desired log routine.



Section 3

Operation 3-31

10. Set Calc=Mean.

11. To capture the minimum and maximum CO2 values, set MinMax accordingly.

12. TCoef has no effect when Calc=Mean.  It is used only when integrating.
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4 Theory of Operation

System Overview

The LI-820 CO2 Gas Analyzer is an absolute, non-dispersive, infrared (NDIR) gas analyzer

based upon a single path, dual wavelength, infrared detection subsystem.  The CO2 measure-

ment is a function of the absorption of IR energy as it travels through the optical path.
Concentration measurements are based on the difference ratio in the IR absorption between a
reference and sample signal.  Reference and sample channels measure CO2 in a single path

through the use of narrow band optical filters with appropriately selected bands.  The CO2

sample channel uses an optical filter centered at 4.24 micrometers.  This filter corresponds to
the absorption band for CO2.  Concentrations of CO2 present in the optical path will result in a

reduction in IR energy as it traverses the optical path.  The reference channel is established
using a filter with a center wavelength at 3.95 micrometers.  It follows that the out-of-band
channel will experience no absorption due to CO2 and thus serves as a reference since the

detector receives the full energy of the source.
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The instrument uses digital signal processing techniques to determine the temperature and
pressure corrected CO2 concentration based on the optical bench signals through the use of a

ratio technique.  The data are passed through a 6th order polynomial that performs
linearization of the detector signal to a mole fraction mixing ratio of CO2 in air given in µmol

CO2 per mole of air, or ppm.

Data output is provided in a digital format through an RS-232 interface that supports
connection to an external computer.  The instrument comes with a Windows®
95/98/NT/2000/XP/ME compatible application for instrument configuration, control, data
collection and display.  Analog signals are available through a terminal block for collection by
a data logger or similar means.  The instrument has an interchangeable optical path that allows
for different concentration ranges as required by a particular application.

Optical Bench System

The LI-820 CO2 Gas Analyzer optical path is a thermostatically controlled IR detection

system.   The optical bench operation is based upon a broad band IR source and a pyroelectric
detector.   The source is mounted in a parabolic reflector to collimate the light and increase
energy throughput down the optical path to the detector.  The reflector and optical path are
gold plated to further increase energy transmission.  The detector is a pyroelectric device that
operates based on thermal energy received.  The narrow band optical filters allow only the
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two wavelengths of interest to illuminate the detector, allowing for the determination of CO2

concentration in the presence of other infrared absorbing gases such as water vapor.

The detector operates responds to thermal energy, so it is necessary to precisely regulate the
detector temperature.  This allows for differentiation of thermal gradient noise from the
received signals from the optical path.  The detection subsystem is shown in Figure 4-1.

Gold Plated
Optical Path

Gold Plated
Parabolic Reflector

Source

Source PCB

Detector

Detector PCB

Broad Band IR Source

Filters
3.95 & 4.24 µm

EEPROM

Pressure Transducer

Heating Element
Heating Element

Gas Inlet Gas Outlet
Thermistor Thermistor

Figure 4-1.  Schematic diagram of LI-820 optical bench.
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The optical bench has a thermostat that maintains a constant operating temperature of 50 °C.
A feedback loop is used to regulate the optical bench temperature.  As shown in Figure 4-1,
two thermistors, located in the source and detector housings, measure the present temperature.
The thermistors are monitored as part of the control loop to determine corrections necessary in
the thermal balance.  Two heating elements are the sources of thermal energy into the source
and detector housing.  The optical path is in mechanical contact with the source and detector
housing and thereby achieves thermal equilibrium.

The bench requires approximately 10 minutes to achieve the specified thermal temperature.  A
longer period of approximately 1.5 hours is required to bring the performance of the detection
system to within 1 to 2% of reading.  As shown in Figure 4-1, the detector housing has a
pressure transducer integrated into the housing design.  Part of the CO2 concentration

calculation depends on the pressure observed in the optical path, measured with an in-line
pressure transducer.  Many parameters can affect the pressure and thus the concentration
reading.  The processing center in the analyzer reads the pressure reading as part of its data
collection task and uses this information in the concentration calculation.  The gas flow enters
the source housing, passes down the optical path and exits at the detector housing.  The
maximum flow rate for the analyzer is approximately 1 liter/min.
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Another key parameter in the concentration calculation is the gas temperature in the optical
path.  It is assumed in the analyzer operation that the gas temperature will equilibrate to the
optical bench temperature (50 °C) by the time it enters the optical path.  Since the instrument
performs temperature and pressure corrections as part of the concentration calculation, this
assumption is very important.  To cause the sample air to equilibrate to the optical bench
temperature, an airflow pattern is created with sufficient eddy currents to cause thermal
equilibration.

The optical bench is mounted in a foam enclosure to accomplish two purposes.  The first is to
assist in maintaining the controlled thermal environment required for the optical bench as
described above.   The second function of the foam enclosure is to protect the optical bench
from mechanical shock and vibration that might damage the mechanically sensitive
components.   The foam enclosure is supported by a optical bench “tray” which is in turn
attached to the main circuit board (PCB).  The optical bench is mechanically de-coupled from
the case by creating the s-bend in the Bev-a-line tubing from the external fittings to the optical
bench gas inlet and outlet connectors.   The electronic interface to the source and detector is
achieved through printed circuit boards mounted directly to the source and detector housings,
respectively.  The PCBs connect the main PCB to the source and detector PCBs via a ribbon
cable.  This achieves the mechanical isolation desired for the optical bench.

Two optical benches are available, depending on the concentration range necessary for the
particular application.  The benches vary in length, resulting in different concentration ranges:
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14 cm (5.5”) Optical Bench
0 – 1000 ppm
0 – 2000 ppm

5 cm (2”) Optical Bench
0 – 5000 ppm
0 – 20000 ppm

The ease of interchangeability for the optical bench options was a consideration from the
beginning of the analyzer design.  The foam enclosure is designed to accept either length
bench while maintaining the two-fold purpose stated earlier.  The electrical connections also
support easy optical bench exchange as well as providing safe interconnection for proper
operation.  The main PCB contains two source headers and one detector header for connection
to the source and detector PCBs via the ribbon cable.  Combining the physical location of the
two source headers with different ribbon cable lengths, the user can easily swap the optical
benches and will be able to select the correct source header on the main PCB.



Maintenance 5-1

5 Maintenance

Cleaning the Optical Bench

The LI-820 optical bench can be removed and cleaned if necessary.  If the optical path
becomes dirty it may become difficult to span the analyzer.  Excessive zero drift may also be
observed if the optical path becomes dirty.  Follow these steps to clean the optical bench:

1. Turn the LI-820 off.  Remove the six screws on the LI-820 top panel and remove the
cover.  Note that these screws are not molded into the case and may fall out.

2. Unscrew the tube retaining nuts on the inner air port fittings.  Remove the tubing from
both air ports.  Leave the tubing connected to the source and detector housings.

3. There are ribbon cables (Figure 5-1 below) connected to the circuit boards on the source
and detector housings.  Pull straight out on the connector that is attached to each ribbon
cable.  The optical bench can now be removed from the foam casing.
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Source
Detector

Air In Air Out

PCBPCB

Optical Bench

Hose Barb

Bev-a-line Tubing
Ribbon Cable
Connector

4. There are four screws on the source and detector circuit boards that must be removed.
Remove the four screws in the corners of the boards, as shown below (they are slightly
larger than the other four screws).  Do not remove the remaining four screws.
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Remove these
4 screws

5. The source and detector housings (with attached circuit boards) can now be removed.
The bench will appear as shown below.  It is a good practice to replace the O-rings when
cleaning or replacing the optical path.

O-ring

Top View

End View
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�

Optical 
Path Swab

Reflector
Swab

6. There are a number of swabs in the spare parts kit (see at left).  Dip one end of the swab
into a 50:50 ethanol/water solution and carefully swab both ends of the optical bench,
until there is no more visible residue.  A mild solution of dish washing type soap and
water will also work.  Do not use abrasive cleansers, as they can irreparably damage the
gold plating on the optical bench.

7. Use a reflector swab and carefully swab the gold-plated concave surface of the source
housing, if necessary.

8. If you need to clean out the hose barbs and/or replace the tubing connected to the source
and detector housings, use a small pair of diagonal cutters to remove the tubing from the
hose barbs.  Use the cutters to pinch the tubing parallel to the hose barb axis, and then
pivot the cutters over the hose barb tip; the tubing will pull off of the hose barb.  Be very
careful not to cut the tubing or scratch the hose barb with the cutters, as subsequent
tubing connections may leak.

9. Let the optical bench dry.  Re-assemble the bench, making sure the O-rings are in place
on both ends of the bench.  Note that the orientation of the cylinder is not important;
either end can be inserted into the source or detector housing.

10. Re-assemble the LI-820 case.  Make sure that the foam insulation on the inside top cover
is positioned over the optical bench; it is required for thermal stability.

11. Perform zero and span calibrations as described in Section 3, Calibration Window.
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Changing the Optical Bench

The 14 cm (5.5") and 5 cm (2") optical benches of the LI-820 can be interchanged to provide
CO2 measurements of 0-2000 and 0-20000 ppm, respectively.  The LI-820 will automatically

sense which optical bench is installed; no further software or hardware switches are required.
To change the optical bench, follow these steps:

1. Follow Steps 1-5 above at Cleaning the Optical Bench to remove the existing bench and
the source and detector housings.

2. Install the source and detector housings on the gold-plated optical path cylinder.  Make
sure that both source and detector housings have an O-ring installed, as shown in Step 5
above.  The orientation of the cylinder is not important; either end can be inserted into the
source or detector housing.  Note:  There is no need to grease the O-ring; simply press
into place.

3. Carefully remove the 10-pin connector that was attached to the source housing circuit
board from the main circuit board.  Reattach the 10-pin connector to one of the
connectors shown below, depending on which optical bench is being installed.
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Connector for 2"
optical bench

Connector for 5.5"
optical bench (not
shown, beneath
tubing)

Fuse

LEDs

Source Detector

Figure 5-1.  Location of 10-pin connectors for 5.5" and 2" optical benches.

4. Install the new bench in the same orientation as the existing bench, with the source side
on the left as you face the front of the instrument.
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5. Reattach the 10-pin connectors to the source and detector housing circuit boards.
Reattach the Bev-a-line tubing to the hose barbs on the source and detector housings, and
to the flow in and out ports, if necessary.  Reassemble the case.

6. Perform zero and span calibrations as described in Section 3, Calibration Window.

Changing the Fuse

The LI-820 power supply is protected by a 1.6A 250V, 5 × 20 mm fast-blow type fuse located
inside the case.  If the battery fails to power the LI-820, and will not light the Power LED on
the top panel, check to see if the fuse has blown.

To check the fuse, remove the six screws on the top of the LI-820.  The fuse is located on the
main circuit board, near the Flow In port, as shown in Figure 5-1.  Replacement fuses (part
#439-04537, in the spares kit) plug into the fuse holder; no soldering is required.  Replace the
fuse and reassemble the LI-820 case.
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A Specifications*

Measurement Range: 0 – 1000 ppm, 0 – 2000 ppm with 14 cm (5.5") optical bench
 0 – 5000 ppm, 0 – 20000 ppm with optional 5 cm (2") optical bench

Measurement Principle: Non-Dispersive Infrared

Accuracy:
5 cm (2") Optical Bench (measurement range 0 - 20000 ppm):
P = 95 to 102 kPa 0 - 1000 ppm; ± 4% of reading ± 10 ppm

1000 - 20,000 ppm; ± 4% of reading
P = 50 to 113 kPa 0 - 1000 ppm; ± 6% of reading ± 10 ppm

1000 - 20,000 ppm; ± 6% of reading
14 cm (5.5") Optical Bench (measurement range 0 - 2000 ppm):
P = 95 to 102 kPa 0 - 200 ppm; ± 3% of reading ± 5 ppm

200 - 2,000 ppm; ± 3% of reading
P = 50 to 113 kPa 0 - 200 ppm; ± 5% of reading ± 5 ppm

200 - 2,000 ppm; ± 5% of reading

Zero Drift: < 1 ppm in 24 hrs at 350 ppm



Appendix A

A-2 Appendix A

Signal Noise: 3.0 ppm pk-pk noise @ 350 ppm (1 sec signal averaging)
1.0 ppm pk-pk noise @ 350 ppm (20 sec signal averaging)

Span Drift: < 3 ppm in 24 hrs at 350 ppm

Pressure Compensation Range: 150 mbars - 1150 mbars

Maximum Gas Flow Rate: 1 liter/minute maximum

Output Signals: 0 – 5V, 0 – 2.5V, 4 – 20 mA

DAC Resolution: 13-bits across specified range

Power Requirements:  Input Voltage 12-30 VDC
1.2A @ 12V (14W) maximum during warm-up with heaters on.
0.3A @ 12V (3.6W) average after warm-up with heaters on.

Warm-Up Time: 1.5 hours

Operating Temp Range: -25
 °C to +45

 °C

Relative Humidity Range: -25 to 45 °C, 0 to 95% RH, Non-Condensing

Dimensions: 8.75” × 6” × 3” (22.23 × 15.25 × 7.62 cm)

Weight: 2.2 lbs. (4.84 kg)

* Specifications subject to change without notice.



Appendix B B-1

B Pin Assignments

DB-9 Connector

 

1

6

2

3

8

7

4

9

5

Data (RXD)

Data (TXD)

Signal Ground (SG)
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C Suppliers

The company names, addresses, and phone numbers are the most current we have at the time of this printing.  In some cases the
information may change without notice.

Soda Lime (6-12 mesh) and Magnesium Perchlorate (Anhydrous) Mg(ClO4)2

GFS Chemicals
P.O. Box 245
Powell, OH  43065
Phone: 614-881-5501
FAX: 614-881-5989
Toll free: 800-858-9682

Soda Lime: Part #66352

Mg(ClO4)2: Part #49001 (500g,

<8% water)
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Fisher Scientific
711 Forbes Avenue
Pittsburgh, PA  15219-4785
Phone: 201-467-6400
FAX: 201-379-7415
Toll free: 800-776-7000
Toll free FAX: 800-926-1166

Soda Lime: Part #S201-212
(LI-COR Part #9960-071)

Mg(ClO4)2: Part #M54-500 (500g)

Thomas Scientific
P.O. Box 99
Swedesboro, NJ  08085-6099
Phone: 609-467-2000
FAX: 609-467-3087
Toll free: 800-345-2100
Toll free FAX: 800-345-5232

Soda Lime: Part #C703-B76

Mg(ClO4)2: Part #C260-M61

(Dehydrite, 500g)
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Electronic Relay Switches

Crydom Inc.
9525 Chesapeake Dr.
San Diego, CA  92123
800-827-9366
FAX: 619-715-7280

Potter & Brumfield Products Div.
Siemens Electromechanical
Components, Inc.
200 S. Richland Creek Dr.
Princeton, IN  47671-0001
info@ae.sec.siemens.com
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D Configuration Grammar

Introduction

The LI-820 communicates exclusively through a serial interface.  The following discussion
describes how to implement a synchronized communication protocol.

LI-820 Communications and XML

The configuration grammar used to communicate with the LI-820 is based upon a subset of
the eXtensible Markup Language (XML).  XML relies on the use of tags to "Markup", or give
structural rules to a set of data.

A tag is a descriptive identifier, enclosed between a less than (<) and a greater than (>)
symbol, used in part to describe a piece of data.  For example, <NAME> is a tag that
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describes a person's name.  Each tag must have a corresponding end tag, denoted by '/'.
Extending the example above, the end tag of <NAME> is </NAME>.

Elements are the basic unit of XML content.  An element consists of a start tag and an end tag,
and everything in between.  For example, consider the following element:

<NAME>George</NAME>.

In this example, <NAME> (start tag) and </NAME> (end tag) comprise the markup, and "George"
comprises the data.  Because XML is extensible, tags can be defined specifically for the data
they are meant to describe.

Elements can also contain other elements other than data.

<NAME>
<FIRST>George</FIRST>
<LAST>Smith</LAST>

</NAME>

In this example, the outermost element <NAME> emcompasses two other elements that contain
data.  All elements combined make up the XML document.
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Connecting and Configuring Data Output

The LI-820 communicates through a serial port on the front of the instrument.  This port is
configured as follows:

Baud Rate: 9600 bps
Data Bits: 8
Parity: None
Stop Bits: 1
Flow Control: None

After a serial connection is established, the LI-820 will immediately send data out the serial
port in the manner in which it was configured previously.  In order to reconfigure the LI-820
to output specific data values, you must send the RS-232 portion of the XML grammar to the
instrument with the desired values "turned on".  To "turn on" the data value, set the value of
the element to TRUE.  As an example, the following string is sent to the instrument after a
connection has been made between the computer (using the Windows® application software)
and the LI-820:

<LI820>
<CFG>

<OUTRATE>{1}</OUTRATE>
</CFG>
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<RS232>
<STRIP>FALSE</STRIP>
<ECHO>FALSE</ECHO>
<CELL TEMP>TRUE</CELL TEMP>
<CO2>TRUE</CO2>
<CO2ABS>FALSE</CO2ABS>
<CELLPRES>TRUE</CELLPRES>
<IVOLT>TRUE</IVOLT>
<RAW>FALSE</RAW>

</RS232>
</LI820>

Sending Data to the LI-820

To send data to the LI-820, each string must end with a '\n' to ensure that the LI-820 can parse
consecutive commands.

After data have been sent to the LI-820, the instrument replies with:

<LI820><ACK>TRUE</ACK></LI820>

if the XML was received and parsed correctly.  If there was an error in the XML, the
following is sent:

<LI820><ACK>FALSE</ACK></LI820>.
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For example, suppose that you would like to reconfigure the LI-820 to stop outputting cell
temperature.  Here is the command to send to the LI-820:

<LI820><RS232><CELLTEMP>FALSE</CELLTEMP></RS232></LI820>

If the command was received correctly, the LI-820 replies with

<LI820><ACK>TRUE</ACK></LI820>.

Reading Data From the LI-820

The LI-820 can send data continuously.  To determine where one message ends and the next
begins, each XML document sent from the LI-820 is delimited with a '\n' (0x10) character.

Polling the Current State of the LI-820

The LI-820 can be polled for individual sets of data by sending an XML document with a '?'
in place of the set of elements requested.  The element sets that can be requested include the
data set, the current configuration, and the entire state of the instrument.

Sending this command:
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<LI820><DATA>?</DATA></LI820>

instructs the LI-820 to send the most recent set of data values (as configured) as an XML
document.

Sending this command:

<LI820><CFG>?</CFG></LI820>

instructs the LI-820 to send an XML document containing all of the configuration
information, including heater status, filter settings, DACs, and alarms.

To receive the entire state of the instrument as an XML document, send this command:

<LI820>?</LI820>.

Calibration

The LI-820 calibration (zero and span) can be performed using XML grammar.  This is
accomplished in three steps:

1. Send the calibration command to the LI-820.
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<LI820>
<CAL>

<DATE>{iso date}</DATE>
<CO2ZERO>{bool}</CO2ZERO>
<CO2SPAN>{int}</CO2SPAN>

</CAL>
</LI820>

2. An acknowledgement is returned from the LI-820 if the command was accepted.

<LI820><ACK>TRUE</ACK></LI820>

3. After about a minute, all of the calibration information is returned from the LI-820,
indicating that it has finished the zero and/or span.

<LI820>
<CAL>

<CO2LASTSPAN>{iso date}</CO2LASTSPAN>
<CO2LASTZERO>{iso date}</CO2LASTZERO>
<CO2KZERO>{float}</CO2KZERO>
<CO2KSPAN>{float}</CO2KSPAN>

</CAL>
</LI820>

If the calibration can not be performed, an ERROR is sent:
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<LI820><ERROR>{Error Text}</ERROR></LI820>.

To Zero the LI-820

1. Send the XML command to initiate the zero.

<LI820>
<CAL>

<DATE>YYYY-MM-DD</DATE>
<CO2ZERO>TRUE</CO2ZERO>

</CAL>
</LI820>

2. Wait for the acknowledgement.

3. Wait for the date to be returned to verify the zero operation succeeded.  If the operation
fails an <ERROR> will be sent.

To Span the LI-820

1. Send the XML command to initiate the span.

<LI820>



Appendix D

Appendix D D-9

<CAL>
<DATE>YYYY-MM-DD</DATE>
<CO2SPAN>Gas Concentration</CO2SPAN>

</CAL>
</LI820>

2. Wait for the acknowledgement.

3. Wait for the date to be returned to verify the span operation succeeded.  If the operation
fails an <ERROR> will be sent.

LI-820 XML Grammar and Element Description

Data Types in the XML Grammar
{val | val |...}

The value will be a member of the specified set.  | = or.
{bool}

Boolean values, TRUE | FALSE.
{float}

Floating point values in decimal or exponential notation.
{int}

Integers.
{iso date}
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A date in the ISO format.  4 digit year - 2 digit month - 2 digit day.
Example: 2002-04-27.

XML Grammar

<LI820>
<ACK>{bool}</ACK>
<VER>{string}</VER>
<DATA>

<CO2>{float}</CO2>
<CO2ABS>{float}</CO2ABS>
<CELLTEMP>{float}</CELLTEMP>
<CELLPRES>{float}</CELLPRES>
<IVOLT>{float}</IVOLT>
<RAW>{integer}</RAW>

</DATA>
<RS232>

<CO2>{bool}</CO2>
<CO2ABS>{bool}</CO2ABS>
<CELLTEMP>{bool}</CELLTEMP>
<CELLPRES>{bool}</CELLPRES>
<IVOLT>{bool}</IVOLT>
<STRIP>{bool}</STRIP>
<ECHO>{bool}</ECHO>
<RAW>{bool}</RAW>

</RS232>
<CFG>
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<OUTRATE>{float}</OUTRATE>
<HEATER>{bool}</HEATER>
<PCOMP>{bool}</PCOMP>
<FILTER>{int}</FILTER>
<ALARMS>

<ENABLED>{bool}</ENABLED>
<HIGH>{int}</HIGH>
<HDEAD>{int}</HDEAD>
<LOW>{int}</LOW>
<LDEAD>{int}</LDEAD>

</ALARMS>
<BENCH>{5|14}</BENCH>
<SPAN>{1000 | 2000 | 5000 | 20000}</SPAN>
<DACS>

<RANGE>{2.5 | 5.0}</RANGE>
<D1>{NONE | CO2 | CELLTEMP | CELLPRES}</D1>
<D2>{NONE | CO2 | CELLTEMP | CELLPRES}</D2>

</DACS>
</CFG>
<CAL>

<DATE>{iso date}</DATE>
<CO2ZERO>{bool}</CO2ZERO>
<CO2SPAN>{int}</CO2SPAN>

or

<CO2LASTZERO>{iso date}</CO2LASTZERO>
<CO2LASTSPAN>{iso date}</CO2LASTSPAN>

</CAL>
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<ERROR>{string}</ERROR>
</LI820>

Element Description

Tag Parent Value(s) Cardinality R/W Comments

<LI820> N/A (root) <DATA>
<RS232>
<CFG>
<CAL>
<ACK>
<VER>
<ERROR>
?

1-N <LI820> is the root tag for
all XML statements.
LI-820 outputs entire
configuration.

Examples:
<LI820>?</LI820>
<LI820><ACK>TRUE</ACK></LI820>
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Tag Parent Value(s) Cardinality R/W Comments

<DATA> <LI820> <CO2ABS>
<CELLTEMP>
<CELLPRES>
<IVOLT>
<RAW>
?

1-N <DATA> contains all data
values sent from the LI-
820.  All of the elements
within the DATA tag are
readable only.  A ?
requests all data values to
be output.

Examples:
<LI820><DATA><CO2>2.34e2</CO2><IVOLT>1.5e2</IVOLT></DATA></LI820>
<LI820><DATA>?</DATA></LI820>
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Tag Parent Value(s) Cardinality R/W Comments

<CO2> <DATA> Float 1-1 R CO2 in ppm

<CO2ABS> <DATA> Float 1-1 R CO2 absorption

<CELLTEMP> <DATA> Float 1-1 R Cell temperature

<CELLPRES> <DATA> Float 1-1 R Cell pressure

<IVOLT> <DATA> Float 1-1 R Input voltage

<RAW> <DATA> Text 1-1 R Raw detector readings

Examples:
<LI820><DATA><CELLTEMP>5.16E1</CELLTEMP><CELLPRES>9.742E1</CELLPRES><CO2>6.
17E2</CO2><CO2ABS>8.94E2</CO2ABS>DATA></LI820>

Tag Parent Value(s) Cardinality R/W Comments

<RS232> <LI820> <CO2>
<CO2ABS>
<CELLTEMP>
<CELLPRES>
<IVOLT>
<RAW>
<ECHO>

1-N Setting <RS232> values
will determine what values
are output in <DATA>
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Tag Parent Value(s) Cardinality R/W Comments

<CO2> <RS232> TRUE | FALSE 1-1 R/W CO2 in ppm

<CO2ABS> <RS232> TRUE | FALSE 1-1 R/W CO2 absorption

<CELLTEMP> <RS232> TRUE | FALSE 1-1 R/W Cell temperature

<CELLPRES> <RS232> TRUE | FALSE 1-1 R/W Cell pressure

<IVOLT> <RS232> TRUE | FALSE 1-1 R/W Input voltage

<RAW> <RS232> TRUE | FALSE 1-1 R/W Raw detector readings

<ECHO> <RS232> TRUE | FALSE 1-1 R/W Echo commands sent to
LI-820

<STRIP> <RS232> TRUE | FALSE 1-1 R/W Strip XML from all data
sent

Example:
<LI820><CFG><OUTRATE>0.5</OUTRATE></CFG><RS232><STRIP>FALSE</STRIP><ECHO>F
ALSE</ECHO><CELLTEMP>TRUE</CELLTEMP><CO2ABS>TRUE</CO2ABS><CO2>TRUE</CO
2><CELLPRES>TRUE</CELLPRES><IVOLT>TRUE</IVOLT><RAW>TRUE</RAW></RS232></L
I820>
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Tag Parent Value(s) Cardinality R/W Comments

<CFG> <LI820> <OUTRATE>
<HEATER>
<PCOMP>
<FILTER>
<ALARMS>
<DACS>
<BENCH>
<SPAN>
?

1-N Elements within the
<CFG> tag control system
settings.

Example:
<LI820><CFG><HEATER>TRUE</HEATER><PCOMP>TRUE</PCOMP></CFG></LI820>
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Tag Parent Value(s) Cardinality R/W Comments

<OUTRATE> <CFG> 0 to 20 1-1 R/W Output data every N
seconds (0.5 s increments).

<HEATER> <CFG> TRUE | FALSE 1-1 R/W Turn heater on/off.

<PCOMP> <CFG> TRUE | FALSE 1-1 R/W Pressure compensation
on/off.

<FILTER> <CFG> 0 to 20 1-1 R/W Set a 0 to 20 second filter.

<ALARMS> <CFG> <ENABLED>
<HIGH>
<HDEAD>
<LOW>
<LDEAD>

1-N High and low alarm
settings.

<DACS> <CFG> <RANGE>
<D1>
<D2>

1-N DAC outputs.

<BENCH> <CFG> 5.5 | 14 1-1 R Optical bench length.

<SPAN> <CFG> TRUE | FALSE 1-1 R/W Span range setting.
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Tag Parent Value(s) Cardinality R/W Comments

<ENABLED> <ALARMS> TRUE | FALSE 1-1 R/W Enable alarms.

<HIGH> <ALARMS> Integer 1-1 R/W High alarm on at this
value.

<HDEAD> <ALARMS> Integer 1-1 R/W High alarm off at this
value.

<LOW> <ALARMS> Integer 1-1 R/W Low alarm on at this value.

<LDEAD> <ALARMS> Integer 1-1 R/W Low alarm off at this
value.

Example:
<LI820<LI820><CFG><ALARMS><ENABLED>TRUE</ENABLED><HIGH>1600</HIGH>
<HDEAD>1500</HDEAD><LOW>200</LOW><LDEAD>300</LDEAD></ALARMS></CFG>
</LI820>
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Tag Parent Value(s) Cardinality R/W Comments

<RANGE> <DACS> 2.5 | 5.0 1-1 R/W Output voltage.  2.5V
or 5.0V.

<D1> <DACS> CO2 | CELLPRES |
CELLTEMP

1-1 R/W DAC1

<D2> <DACS> CO2 | CELLPRES |
CELLTEMP

1-1 R/W DAC2.

Example:
<LI820><CFG><DACS><RANGE>2.5</RANGE><D1>CO2</D1><D2>CELLTEMP</D2></DACS><
/CFG></LI820>

Tag Parent Value(s) Cardinality R/W Comments

<CAL> <LI820> <DATE>
<CO2ZERO>
<CO2SPAN>
<CO2LASTZERO>
<CO2LASTSPAN>
<CO2KZERO>
<CO2KSPAN>

1-N Calibrating
parameters.  When
calibrating, <DATE>
must be paired with a
<CO2ZERO> or a
<CO2SPAN>.
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Tag Parent Value(s) Cardinality R/W Comments

<DATE> <CAL> 20 character
date

1-1 W The date the calibration is
taking place.

<CO2ZERO> <CAL> TRUE | FALSE 1-1 W Start a CO2 zero.

<CO2SPAN> <CAL> Integer (CO2
ppm)

1-1 W Start a CO2 span.

<CO2LASTZERO> <CAL> 20 character
date

1-1 R The date the LI-820 was
last zeroed.

<CO2LASTSPAN> <CAL> 20 character
date

1-N R The date the LI-820 was
last spanned.

<CO2KZERO> <CAL> Float 1-N R/W Calibration constant.

<CO2KSPAN> <CAL> Float 1-1 R/W Calibration constant.
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Examples:
To Zero:
<LI820><CAL><DATE>2001-02-07</DATE><CO2ZERO>TRUE</CO2ZERO></CAL></LI820>
To Span:
<LI820><CAL><DATE>2001-02-07</DATE><CO2SPAN>1000</CO2SPAN></CAL></LI820>
Possible LI-820 Replies
<LI820><ACK>TRUE</ACK></LI820>
<LI820><ERROR>{ErrorText}</ERROR></LI820>
<LI820><CAL><CO2LASTSPAN>
{isodate}</CO2LASTSPAN><CO2LASTZERO>{isodate}</CO2LASTZERO><CO2KZERO>{float}
</CO2KZERO> <CO2KSPAN>{float}</CO2KSPAN> </CAL></LI820>

Tag Parent Value(s) Cardinality R/W Comments

<ACK> <LI820> TRUE | FALSE 1-1 R Acknowledgement to a
send command.

<VER> <LI820> Text 1-1 R Embedded software
version.

<ERROR> <LI820> Text 1-1 R Error.  Includes a message.



Warranty

Each LI-COR, inc. instrument is warranted by LI-COR, inc. to be free from defects in material and workmanship; however, LI-COR, inc.'s sole
obligation under this warranty shall be to repair or replace any part of the instrument which LI-COR, inc.'s examination discloses to have been
defective in material or workmanship without charge and only under the following conditions, which are:

1.  The defects are called to the attention of LI-COR, inc. in Lincoln, Nebraska, in writing within one year after the shipping date of the
instrument.
2.  The instrument has not been maintained, repaired, or altered by anyone who was not approved by LI-COR, inc.
3.  The instrument was used in the normal, proper, and ordinary manner and has not been abused, altered, misused, neglected, involved in and
accident or damaged by act of God or other casualty.
4.  The purchaser, whether it is a DISTRIBUTOR or direct customer of LI-COR or a DISTRIBUTOR'S customer, packs and ships or delivers
the instrument to LI-COR, inc. at LI-COR inc.'s factory in Lincoln, Nebraska, U.S.A. within 30 days after LI-COR, inc. has received written
notice of the defect.  Unless other arrangements have been made in writing, transportation to LI-COR, inc. (by air unless otherwise authorized
by LI-COR, inc.) is at customer expense.
5.  No-charge repair parts may be sent at LI-COR, inc.'s sole discretion to the purchaser for installation by purchaser.
6.  LI-COR, inc.'s liability is limited to repair or replace any part of the instrument without charge if LI-COR, inc.'s examination disclosed that
part to have been defective in material or workmanship.

There are no warranties, express or implied, including but not limited to any implied warranty of merchantability of fitness for a
particular purpose on underwater cables or on expendables such as batteries, lamps, thermocouples and calibrations.

Other than the obligation of LI-COR, inc. expressly set forth herein, LI-COR, inc. disclaims all warranties of merchantability or fitness
for a particular purpose.  The foregoing constitutes LI-COR, inc.'s sole obligation and liability with respect to damages resulting from
the use or performance of the instrument and in no event shall LI-COR, inc. or its representatives be liable for damages beyond the
price paid for the instrument, or for direct, incidental or consequential damages.



The laws of some locations may not allow the exclusion or limitation on implied warranties or on incidental or consequential damages, so the
limitations herein may not apply directly.  This warranty gives you specific legal rights, and you may already have other rights which vary from
state to state.  All warranties that apply, whether included by this contract or by law, are limited to the time period of this warranty which is a
twelve-month period commencing from the date the instrument is shipped to a user who is a customer or eighteen months from the date of
shipment to LI-COR, inc.'s authorized distributor, whichever is earlier.

This warranty supersedes all warranties for products purchased prior to June 1, 1984, unless this warranty is later superseded.

DISTRIBUTOR or the DISTRIBUTOR'S customers may ship the instruments directly to LI-COR if they are unable to repair the instrument
themselves even though the DISTRIBUTOR has been approved for making such repairs and has agreed with the customer to make such repairs
as covered by this limited warranty.

Further information concerning this warranty may be obtained by writing or telephoning Warranty manager at LI-COR, inc.

IMPORTANT:  Please return the User Registration Card enclosed with your shipment so that we have an accurate record of your address.
Thank you.



LI-COR, inc.  ●   Environmental ●  4421 Superior Street  ●   P.O. Box 4425 ●   Lincoln, Nebraska  68504 USA
Phone: 402-467-3576  ●   FAX: 402-467-2819

Toll-free 1-800-447-3576 (U.S. & Canada)
E-mail: envsales@licor.com
Internet: http://www.licor.com


	Table of Contents (linked)
	1. General Description
	2. Power On
	3. Operation
	4. Theory of Operation
	5. Maintenance
	Appendix A. Specifications
	Appendix B. Pin Assignments
	Appendix C. Suppliers
	Appendix D. Configuration Grammar

